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Train Simulator – Průvodce Route Explorer 

Část II. Editor Aktivit a Editor Souprav 
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Dříve než začnete 
 
Editor aktivit (EA) je pevnou součástí komplexního nástroje TSRE5 a řada jeho funkcí, která byla 
popsána pro Editor tratí, najde uplatnění i při tvorbě aktivit. EA je tedy pouze jedním rozsáhlejším 
funkčním celkem celého TS Route Exploreru. 
Mezi příkazy, které najdou uplatnění v Editoru tratí i Editoru aktivit, patří např.: 
 

 Funkce uložení Route→Save (Trať → Uložit) nebo příslušná klávesová zkratka; 
 

 Funkce ukončení programu Route→Exit (Trať → Konec) nebo příslušná klávesová zkratka; 
 

 V menu Settings lze v případě potřeby využít příkazy Stick kamera to terrain (Přidržet kameru 
u povrchu terénu), MSTS shadows (Nastavení  → Stínování podle MSTS, což vypne / zapne 
většinu stínování) a konečně Terrain Editing (Nastavení  → Editace terénu). Výběr: Detailed / 
Distant (detailní / potlačený terén) znamená buď plné zobrazení, nebo potlačení textur terénu s 
ponecháním viditelnosti pouze objektů. Tím se může snížit zátěž programu TSRE5 na 
hardwarové prostředky vašeho PC. 

 
Podstatný vliv na funkci TSRE má i vyhovující nastavení parametrů v souboru setting.txt. To je 
popsáno v úvodní části Editoru tratí. 
Dále je nutné dodržet zásady, uvedené v části návodu Editor tratí – Dříve než začnete. To znamená 
mít vytvořen kořenový adresář / gameRoot MSTS nebo instalační profil OR, v němž budou uloženy 
složky Routes, Global, Trains, nejlíp mimo systémové adresáře Program Files a Program Files (x86). 
O možných potížích, pokud jsou MSTS a OR instalovány v rámci těchto složek, byla napsána řada 
příspěvků na MSTS Fóru nebo na stránkách stavitelů tratí, tvůrců modelů a aktivit. 

 

Práce s aktivitami 
 

Stiskni F4 nebo vyber záložku Tools→Activity (Nástroje -> Aktivity). V pravém postranním panelu se 

namísto nástrojů pro stavbu tratí objeví nástroje s parametry pro tvorbu nových aktivit (a editaci 

stávajících). 

 

Výběr stávající aktivity 
 
Vyber již vytvořenou aktivitu ze seznamu. 
Tlačítko Open Service Editor (Otevřít editor servisů) spustí editaci aktivity – použitých servisů. 
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Vytvoření nové aktivity 
 
Úvodem je nutno poznamenat, že Editor aktivit, který je součástí TSRE5, dovoluje sestavit aktivitu 
ACT na základě vytvoření tzv. servisů SRV pro hráče i plánovaný okolní provoz. Servisy pro okolní 
provoz se zapisují do souboru TRF. 
Vytvoření plnohodnotného servisu předpokládá, kromě jiného, vytvoření požadované soupravy CON a 
přiřazení trasy PAT, po níž se bude vlak pohybovat. 
K sestavení soupravy lze mj. použít Editor souprav, který je součástí TSRE5 – viz následující 
kapitola. 

 
Vytvoření trasy je v současné podobě TSRE nedostupné a proto je možné použít např. 
nástroj, dostupný v simulátoru OpenRails – Track Viewer (pokud to vámi používaná 
verze OR umožňuje). 
 

Kliknutím na tlačítko New Activity (Nová aktivita) v sekci Activity List (Přehled aktivit) se spustí tvorba  
nové aktivity. 

 
 
 
 
 
 
 
 
 

V rozbalovací nabídce, která může obsahovat názvy všech doposud zpracovaných aktivit pro danou 
trať, se musí zobrazit označení „NewActivity0“. Až poté je možné otevřít editační panel pro zadání 
základních parametrů nové aktivity. Tento panel je dostupný v sekci Activity Info (Informace o aktivitě) 
– viz následující kapitola. 

 

Editace základních parametrů aktivity 
 
Vytvoření nové aktivity v praxi znamená (podobně jako u MSTS AE) definovat její základní parametry, 
jako např. název, čas zahájení, obtížnost, denní a roční dobu, počasí a umožňuje vložit základní 
popisné údaje. Na rozdíl od MSTS AE lze použít znaky s českou diakritikou. 
Potom je nutné v další fázi vytvořit nové servisy (SRV) pro hráče a okolní provoz a tento provoz 
definovat (TRF). 

 
Klikněte na tlačítko Open Settings (Otevřít nastavení) tamtéž.  
 
 
 
 
 
 
 
Otevře se okno se základními informacemi o aktivitě. Viz následující obrázek:  
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File Name  Název souboru aktivity ACT 
 

Tento název po prvním provedeném uložení se již nedá změnit. Tento název se objeví ve složce 
Activities příslušné trati. Případná změna je možná pouze pomocí textového editoru a je náročná 
na znalosti adresářové struktury, kterou každá aktivita vytváří. Není náplní tohoto návodu. 

 
Display Name    Zobrazovaný název 
 

     Zobrazuje název aktivity, se kterým pracuje jak editor, tak jiné pomocné programy včetně OR.  

     Název se v TSRE objeví až po restartu programu. 

 

Zde je vřele doporučeno používat shodný název, jímž jste pojmenovali aktivitu (soubor 
ACT) v předchozím bodě. Velmi to ulehčuje orientaci v další práci. 

 

 

Difficulty    Obtížnost 

Očekávaná obtížnost hry podle autora aktivity. Jinak asi nemá na nic vliv (Easy – Medium – Hard) 
 

Duration    Doba trvání 

Opět pouze časový údaj informačního charakteru 
 
Start Time   Počáteční čas 

Zde je určen čas zahájení aktivity. Jde o tzv. čas „0“, od kterého jsou odpočítávány všechny další 
události v aktivitě. 

 
Season + Weather     Roční období a počasí 

Nastavení vnějších podmínek aktivity, např. podzim / déšť nebo zima / sníh. Jednotlivé definice 
zejména u počasí nejsou nejšťastnější a autoři OR by mohli počasí definovat jinak. Např.: Jasno – 
Snížená viditelnost – Srážky oproti stávajícímu Jasno – Déšť – Sníh. 

 
Horn at Crossing     Požadavek výstražného signálu před přejezdem 

Po zaškrtnutí je nutné používat výstražný signál před nechráněným železničním přejezdem. 
Nedodržení má za následek vyhodnocení chyby v závěrečné zprávě aktivity (t.č. nefunkční). 
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Fuel Coal / Diesel / Watter     Stav provozních náplní – uhlí / nafta / voda 

Posuvníkem (nebo přímou editací hodnoty) lze nastavit množství provozních náplní (v %) na 
hnacích vozidlech odpovídající trakce na počátku aktivity. Na základě zapsaných hodnot se dají 
vybudovat zajímavé „dojezdové“ aktivity pro skutečně zkušené hráče. 

 
Hazzard Animal / People     Rizikový faktor zvířata / lidé 
Opět se jedná spíše o efekt než o opravdové ohrožení hráče v aktivitě. Posuvníky nebo vložením 
potřebné hodnoty se zadá procento tzv. ohrožení živými tvory. Má to vliv na četnost jejich výskytu. 
 
Description / Briefing      Popis / Instrukce 
Stručná charakteristika aktivity a hráčské instrukce pro plynulý chod aktivity.  
 

Dobře vyprojektovaná aktivita musí v těchto polích poskytnout základní informace o 
aktivitě (např. použité vozidlo, projížděná trasa), o úkolech (např. připojení / odpojení 
vozů), mimořádných událostech (pomalá jízda, vyčkávání) atd. Doprovodnému textu by 
měla být věnována ze strany autora pozornost, protože je tím prvním, s čím se hráč 
setkává a co může (nebo nemusí) vzbudit jeho zájem. 
 

 

Definice servisu hráče 
 
Servis hráče se definuje pomocí samostatné sekce Player (Hráč): 

 
 
 
 
 
 
 
 

Vytvoření a editace servisu hráče je možné provádět rovněž v případě, že není dosud přiřazen do 
nějaké aktivity. 
Stisknutím tlačítka Open Service Editor (Otevřít editor servisů) se otevře okno Services (Servisy), kde 
můžeme hráči přidělit libovolný již hotový servis nebo vytvořit úplně nový. 
Toto okno je shodné s oknem popsaným v kapitole Práce se servisy (SRV). 

 
 
Editační okno se využívá rovněž pro vytváření servisů okolního provozu! 
Pozor na „promíchání“ servisů z různých aktivit! 

 
 

Volné / statické soupravy (Loose Consist - LC) 
 

Umístění volné / statické soupravy  
Tzv. volná / statická souprava se vyznačuje mimo jiné tím, že neobsahuje aktivní hnací vozidlo či 
manipulační servis (přítomnost ENG) a není pro ni vytvářen zvláštní soubor SRV. Je tvořena jen 
vozidly či manipulačními servisy typu WAG. Zapisuje se přímo do řídícího souboru ACT. 
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Activity object List – panel pro Přehled cílů aktivity, který umožňuje manipulaci s volnými soupravami 
(LC): 

 Jump to (Přejdi na označenou soupravu),  

 Delete (Smaž označenou soupravu), 

 Place Consist (Umísti soupravu na kolej), 

 Consist (Výběr soupravy CON ze seznamu), 

 Refresh List (Obnova seznamu dostupných souprav). 
 
Pozn.: toto okno je aktivní tehdy, pokud je potřeba vložit novou volnou soupravu nebo 
pracovat s již existující LC. Jejich přehled je dostupný pomocí rozbalovacího seznamu 
v horní části panelu. 
 

Pole Consist s rozbalovacím seznamem všech dostupných souprav je určeno k výběru LC. Další 
editační možnosti LC jsou popsány v předchozím odstavci a používají se podle následující metodiky. 

 

 
Ze všeho nejdříve musíte mít otevřenou stávající / založenou novou aktivitu, jinak 
statickou soupravu nelze vložit – nezobrazí se. 
 
 

1. Vyberte a označte potřebnou soupravu ze seznamu dostupných souprav. Z ní bude vytvořena tzv. 
statická souprava (LC). 

 
2. Klikněte na tlačítko Place Consist (Umístit soupravu). 

 
3. Vyberte kolej, na kterou potřebujete umístit soupravu tak, že na tuto kolej kliknete levým tlačítkem 

myši. Volná souprava bude osazena do místa výběru.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
Pokud chcete soupravu na koleji otočit, tak ji nejdříve označte levým tlačítkem. K tomu použijte 
výběrový mód Edit → Select Tool nebo klávesu E. Příznakem správného výběru je červený kvádr 
kolem vozidla – viz následující obrázek. Poté pravým tlačítkem myši otevřete plovoucí menu pro výběr 
pomocných funkcí a v něm příkaz Object (Activity Object) → Toggle Direction (Změna směru).  
 

Po umístění statické soupravy nezapomeňte klepnutím na tlačítko vkládání LC ukončit! 
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Situace před úpravou otočení vlaku: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A takto to bude vypadat ve finále, po otočení vlaku: 
 
 
 

 

 

 

 
 
 
 

 

Funkce Object (Activity Object) → Reverse Selected (Obrátit označené vozidlo) umožňuje, už 

podle názvu, obrátit označené vozidlo, tj. vozidlo s červeným ohraničením. Příkaz dostupný jen 

v některých verzích TSRE. 

Další příkazy v plovoucím menu slouží k běžné práci se soupravou ve schránce a k základním 

editačním úkonům. 

 

Pohyb s volnou / statickou soupravou 

Pro pohyb s označenou statickou soupravou (tj. po kliknutí na libovolné vozidlo, které je v ní 

zařazeno) držte tlačítko myši a opatrně pohybujte směrem vpřed / vzad. 

 

Odstranění volné / statické soupravy  
Pokud je potřeba nějakou volnou / statickou soupravu smazat, označte ji a stiskněte tlačítko Delete 
(Odstranit). Můžete použít jak tlačítko uvnitř panelu statických souprav, tak i tlačítko v levém panelu 
(vlastnosti označeného objektu) 
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Přechod mezi volnými / statickými soupravami 
Tlačítko Jump to (Přejít na) slouží k rychlému přemisťování mezi volnými soupravami v aktivitě, pokud 
vznikl požadavek je nějakým způsobem dále editovat. Statickou soupravu, k níž je třeba přejít, vyberte 
/ označte z rozbalovacího seznamu použitých LC (nachází se pod nápisem Activity object List - 
Přehled cílů aktivity). Pohled / kurzor se přemístí nad označenou soupravu. 

 

Velkou službu vám může poskytnout při umisťování statických souprav (a v budoucnu 
možná i při definování jízdních tras PAT servisů hráče a okolního provozu) vypnutí 
pomocných traťových grafik (menu View), jako jsou: linie kolejí v TDB, linie TSection, 
linkování návěstidel, značky a podobně. Zvýší se tím podstatně přehlednost práce, 
zejména při osazování velkých stanic. 

 

Práce se servisy (SRV) 
 
V této fázi sestavování aktivity vytvoříme soubory servisů (SRV), ve kterých budou definovány použité 
vlakové soupravy (CON), jejich jízdní trasy (PAT) a další parametry a to jak pro hráče, tak pro okolní 
provoz (TRF). 
Soupravy (CON) vytvoříme např. pomocí nástroje „TSRE ConEdit“, dostupného samostatným 
spouštěcím souborem consisteditor.bat (nebo zástupcem na ploše s parametrickým spouštěním 
např. x:\TSRE5\TSRE5_v0.69752.exe –conedit, kde x: je označení disku, na němž je TSRE5 
nainstalován podle metodiky, uvedené v úvodu). Pozn.: existují i další možnosti, jak soupravu vytvořit 
– dle zkušeností každého uživatele. 

 
Jízdní trasy (PAT) vytvoříme např. nástrojem OR – Track Viewer, protože TSRE5 nic 
podobného v současné podobě neobsahuje. Panel Path (Trasa) je nefunkční. 
 

 

Okno editoru servisů 
  
Klikni na tlačítko Open Service Editor (Otevřít editor servisů).     
Otevře se pracovní okno Services (Servisy), důležité pro vytvoření a editaci servisů hráče a okolní 
dopravy (tzv. „traffic“). Na pečlivosti  práce závisí výsledek vaší práce. Proto je doporučeno celé okno 
a jeho funkce pečlivě prostudovat! Pro ty, co někdy pracovali s MSTS AE není pochopení účelu 
jednotlivých funkcí nic obtížného. 
Chcete-li pracovat s některým stávajícím servisem, vyhledejte jej v seznamu (pole 1), označte jej 
(oranžové podbarvení názvu). Pokud je součástí vybrané aktivity, bude zatržítko ve sloupci 2 a 3. 
Zatržítko v poli 4 by mělo být u všech dostupných servisů, které jsou správně zadány. V panelech 
Service Info, Consist a Path (Údaje servisu, Souprava, Trasa) se zobrazí veškeré potřebné informace 
a data pro možné editování. 

 
Postřeh aktivitáře: Při vkládání hotových servisů pro okolní provoz do souboru TRF je 
nutné (za předpokladu použití funkce Timetable – Jízdní řád) dodržet metodiku, 
popsanou v kapitole Specifika vkládání servisů s jízdním řádem. 
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1. Sloupec NAME: označení / výběr použitelných servisů hráče a provozu pro aktuálně vybranou 

aktivitu. 
2. Pole s přehledem dostupných servisů 
 
3. Sloupec THIS: označení servisů použitých ve zvolené aktivitě. 
 
4. Sloupec ANY: Označení servisů, které jsou použity v ostatních aktivitách nebo též seznam všech 

obecně dostupných servisů. 
 
5. Kliknutím na tlačítko New Service (Nový servis) vytvoříte další servis. 
 
6. Kliknutím na tlačítko Delete (Odstranit) smažete označený servis. Zatím není funkční, odstranit jej 

musíte přímo ve složce servisů pro používanou trať. Nebylo ověřeno. 
 
7. File Name (Název souboru servisu) – po vytvoření / uložení není možné jej měnit. 
 
8. Display Name: (Zobrazovaný název servisu), doporučujeme stejné pojmenování jako v bodě 7. – 

tento název je možné editovat. Tento název bude zobrazován v dalších fázích vytváření aktivity, 
v různých přehledech atd. 
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9. Vlastnosti servisu. Zde se otvírá možnost nastavení počáteční a konečné rychlosti (Start speed / 
End Speed). Editovatelný údaj. 

 
10. Výběr soupravy - Consist (z nabídky existujících), která bude pro tento servis použita. 
 

11. Přidělení vlakové trasy - Path pro tento servis (při použití vybrané soupravy dle 10.). Změna trasy 
vynuluje údaje v TIMETABLE (jízdní řád) pro servis a je proto třeba jej znovu přepsat. V praxi jde o 
případ, kdy byl např. použit servis z jiné aktivity, ale jízdní řád - timetable – je nutné v tomto případě 
napsat znovu, s ohledem na aktivitu, kde bude nově použit. Je to stav, kdy při editaci trasy 
(lhostejno, zda pro hráče či pro okolní provoz) je nutné upravit jízdní řády (pokud samozřejmě 
existují) pro všechny zastávky ZA změnou trasy. 

 
12. Seznam projížděných vlakových zastávek na trase; zaškrtnutím ve sloupci „Stop“ můžete označit, 

zda ve stanici bude vlak stavět či nebude: viz obrázek „Timetable“... 
 
Ve sloupci Distance (Vzdálenost) je údaj o vzdálenosti z výchozího bodu aktivity (0 km) 
do jednotlivých stanic na trase. Význam má především pro editaci servisu hráče. 
 
 

13. Seznam souborů / aktivit *.act, které používají tento servis. 

 

Timetable – jízdní řád 
 
Pro otevření obecného editoru jízdních řádů slouží tlačítko Open Timetable Editor (Otevři editor 
jízdního řádu), na nástrojovém panelu vpravo od pracovního náhledového okna. Nejdříve je nutné 
nastavit aktivitu, pro niž bude jízdní řád upravován – stávající nebo nová. 

 
V okně editoru proveďte výběr servisu (nejčastěji pro hráče) dle názvu a označte jej (panel vlevo). 
V pravém poli jsou ve sloupci Station (Stanice) uvedeny stanice, v nichž bude vlak zastavovat, ve 
sloupci Arrive (Příjezd) se zadává čas příjezdu do stanice a ve sloupci Depart (Odjezd) se definují 
odjezdové časy. Sloupec Performance (Výkon) se vkládá hodnota přednastaveného výkonu, 
nominálně 0,75.  
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Pokud při editaci označíme v panelu Traffic (Provoz) soubor TRF, který odpovídá vybrané aktivitě, 
máme možnost přístupu k bezpečnému sestavování jízdních řádů všech připojených servisů okolního 
provozu zvolené aktivity, nejen hráče – viz obrázek!. 

 
Pokud nekoresponduje výběr názvu aktivity a přidruženého provozu TRF, máme sice 
v seznamu servisů (vlevo) uveden správně servis hráče, ale spolu s ním se společně 
zobrazí servisy okolního provozu. A při jejich editaci může snadno vzniknout zádrhel…  
 
PEČLIVĚ zkontrolujte, zda veškeré náležitosti aktivity jsou správně vybrané / zadané / 
definované! Předejdete nepříjemným komplikacím. Zásah do definice plánovaných 
zastávek má za následek nutnost znovu zadat celý jízdní řád! 
 
 
POZOR! Otáčením kolečka myši na rozbalovacích nabídkách se mění např. soubor 
okolního provozu atd. Při nepozornosti může snadno dojít k záměně za jiný. 
 

 

Vytvoření nového servisu 
 
Tvorba nových servisů je možná po použití tlačítka Open Service Editor (Otevřít editor servisů) 
v panelu Player (Hráč). 
Klikněte na tlačítko New Service (Nový servis) – viz bod 5., otevře se okno pro vložení názvu servisu. 
 
 
 
 
 
 
 
 
 
 
 
 
Výběr servisu hráče. Servis nemusí být nutně pojmenovaný s ohledem na jeho přidělení hráči, ale 
takové pojmenování zvyšuje spolehlivost orientace mezi dalšími. Servisem hráče může být každý 
dostupný servis. 
Další postup se děje podle výše popsané metodiky, tj. vložení základních údajů servisu, přidělení 
soupravy a trasy. 
  
Nyní vyberte již připravený servis, který chcete přiřadit hráči. 
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Práce se soubory provozu (TRF – traffic) 
 

Editační panel Traffic 
 
V panelu Traffic klikněte na Open Traffic Editor (Spustit editaci okolního provozu): 
 
 
 
 
 
 
 
 
 
 

  
Otevře se nové definiční okno: Traffic (Provoz). Opět se doporučuje pozorně nastudovat význam 
jednotlivých položek / proměnných, jako v případě okna Servisu.  
Práce se dostává do další fáze, kdy pro vytváření simulovaného okolního provozu (TRF) přidělujete 
požadované servisy (SRV) a definujete pravidla jejich nasazení / odebrání z aktivity atd. – viz dále. 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Seznam všech dostupných souborů okolního provozu (TRF). 
 
2. Sloupec THIS: označení provozu pro použití v dané aktivitě. 

 
3. Sloupec ANY: seznam ostatních souborů provozu (TRF), použitých v jiných aktivitách. 

 
4. Klikni na tlačítko New Traffic (Nový soubor provozu), čímž se založí vytvořit další soubor TRF. 

 
5. Klikni na tlačítko Delete (Smazat) za účelem smazání vybraného provozu. Není funkční, nutno 

smazat ve složce hry (neověřováno). 
 
6. Pole Name (Název) slouží pro zadání názvu provozu (TRF). Po vytvoření není možné editovat. 
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7. Pole Services (Servisy) obsahuje seznam všech servisů, zařazených do editovaného souboru 
provozu. Zobrazuje se také čas, kdy bude nasazen ve hře. Kliknutím můžete měnit nastavení. 

 
8. Tlačítko Add New (Vložit nový) přidá označený servis. Použijte až po zadání požadovaných 

parametrů. 
 
9. Tlačítko Remove selected (Odstranit označený servis) smaže vybraný servis ze seznamu.  

V některých verzích TSRE nebylo mazání funkční. 
 

10. Panel Selected Service (Vybraný servis) se používá pro výběr funkčního servisu (SRV) a k 
nastavení času, kdy se má ve hře objevit. Tento čas se promítne rovněž v 7. 

 
V některých verzích TSRE je ještě k dispozici tlačítko Clone Selected (Naklonovat označený servis). 

 

Vytvoření nového provozu 
  
Kliknutím na tlačítko New Traffic (Nový provoz) se otevře nové okno – vložte název vašeho provozu. 
Je doporučeno kvůli lepší orientaci použít shodný název, jaký byl použit pro pojmenování aktivity 
(ACT). 
 
 
 
 
 

 

 
 
 
 
 
 
 
Výběr provozu pro aktivitu:    
Zde jsou k dispozici všechny již hotové soubory provozu (TRF)  
Nyní vyberte podle názvu soubor okolního provozu, který jste si dříve vytvořili. 
  
 
 
 
 
 
 
 
 
 
Editor aktivity obsahuje řadu dalších panelů, které nejsou dosud plně funkční nebo nejsou popsány 
v originálním návodu TSRE5. Plánovány jsou pro tvorbu tras, stanovení úkolů aktivity, úseky pomalé 
jízdy, nefunkční návěstidla atd. 
 

Specifika vkládání servisů provozu s jízdním řádem 

Vkládání servisů do provozu (TRF) je podle předchozí metodiky poměrně jednoduché: z nabídky 
vybereme vhodný servis a zadáme čas, v němž bude spuštěn (bod 10). Obsah souboru TRF (vložené 
servisy) je vypsán v poli Services (bod 7) vč. časů inicializace. 
Problém může nastat, potřebujeme-li k některému servisu zadat jízdní řád pomocí panelu Timetable 
(Jízdní řád). Tento panel nemusí být přístupný nebo může zobrazovat POUZE servis hráče; není tedy 
možné zadat časy příjezdu a odjezdu pro servisy okolního provozu. 
Proto je nutné: 
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 Označit v rozbalovací nabídce aktivitu (dle pracovního názvu), pro niž je okolní provoz definován. 
 
 Po ukončení práce s přidělováním servisů kliknutím označit v rozbalovací nabídce volbu Undefined 

(sekce Traffic – Provoz) v panelu nástrojů pro EA. 
 
 Znovu nastavit v rozbalovací nabídce požadovaný TRF a použít tlačítko Open Traffic Editor 

(Spustit editaci okolního provozu). V panelu okolního provozu se zobrazí nabídka všech servisů 
(vč. startovacích časů), do zvoleného provozu již začleněných. 

 
 Otevřít panel Timetable (Jízdní řád) pomocí tlačítka Open Timetable Editor (Otevřít editaci JŘ) 

 
 V přehledu servisů zvolené aktivity označit ten, pro který bude JŘ zadáván. 

 
 V panelu Timetable zadat JŘ (s ohledem na vybrané stanice) systémem čas příjezdu / čas odjezdu 

v příslušných rubrikách: Arrive / Depart. Zde je způsob zadávání oproti MSTS AE jednodušší – viz 
kapitola Timetable – jízdní řád. 

 
 Po vložení JŘ ukončit funkci Timetable, případně zpracovat JŘ pro další servis obdobným 

způsobem. 
 
 Uložit aktivitu pomocí menu nebo klávesové zkratky. 

 
 

 
Při dalším „sezení“ (rozšiřování provozu o další servisy s editací JŘ v jiný čas / den) je 
postup práce s TRF a Timetable shodný. Úprava JŘ stávajícího servisu je možná, ale jen 
při dodržení uvedených zásad. 
 

Bez výběru / nastavení aktivity není možné používat panel Timetable, třebaže je správně 
nastaven název okolního provozu! 
 
 
Přestože se zdá, že podle logiky není nutné cyklus TRF – Undefined – TRF provádět u 
servisů, které nemají jízdní řád, aktivitář DOPORUČUJE tento proces PROVÉST! 
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Editor souprav je plně integrovanou součástí aplikace TSRE5. Je spustitelný prostřednictvím 
parametru v příkazovém řádku při spouštění TSRE5. V řádku Vlastnosti - Cíl (zástupce TSRE5) je 
uveden parametr " -conedit" – např. . ..\TSRE5_v0.69752.exe –conedit. Stejnou funkci zabezpečuje 
rovněž, soubor ConsistEditor.bat, který je součástí aplikace. Viz další část. 
 

• Chcete-li používat Editor souprav, musíte mít verzi TSRE5 - V0.6124 nebo vyšší. 
 

• Musíte upravit soubor settings.txt a v něm nastavit cestu k adresáři MSTS, kde se nachází 

složky tratí používaných OR - Routes a složka vlaků - Trains, Příklad: gameRoot = F: / train 

simulator. Místo „F:“ samozřejmě uveďte označení disku, na němž máte MSTS nainstalován. 
 

• Spusťte soubor ConsistEditor.bat z příkazového řádku. Podle dalšího způsobu spouštění editoru 

můžete pomocí Průzkumníka Windows zkopírovat soubor ConsistEditor.bat do schránky a poté jej 

pomocí „Vložit zástupce“ uložit třeba na plochu. Potom lze jednoduše pomocí této nové ikony na 

ploše spustit vlastní Editor souprav. Tento způsob se jeví jako jednodušší, pokud z nějakého 

důvodu nechcete zasahovat do vlastností souboru *.BAT. 

 

Jak používat Editor souprav 
 

Menu File (Soubor) 
 
File→New      Soubor → Nový 
 
     Příkaz spustí editaci nové vlakové soupravy. Tímto tlačítkem musí začínat sestavování jakékoliv 
soupravy. Až poté je možné zadat její název (File Name a Display Name) a zahájit vlastní řazení 
vozidel. Údaj Display Name (Zobrazovaný název) je nepovinný. Při zadávání je možné použít českou 
diakritiku. Údaj File Name (Název souboru - CON) je naopak povinný, ale po uložení souboru CON ho 
již nelze pomocí TSRE editovat! Je doporučeno v tomto případě české znaky nepoužívat. 
 

File→Save      Soubor → Uložit 
 

Příkaz uloží aktuálně otevřenou / rozpracovanou soupravu (např. při náhradách vozidel, rozšíření 
nebo zkrácení souprav, změně zobrazovaného názvu apod.). 

 

File→Exit       Soubor → Ukončit 
 

Příkaz je určen k ukončení práce s programem TSRE5 – Editor souprav. Veškerá rozdělaná a 
dříve neuložená práce bude programem nabídnuta k uložení.  

 

Pokud jste provedli změny v souborech CON a neuložili je sami před ukončením 
programu, zobrazí se v rozbalovací nabídce Save Changes (Uložit změny). 
Zároveň jste informováni o souborech (výpis zobrazí tzv. Display Name), kterých se 
uložení týká (viz následující obrázek):  

 
Save and Quit – uloží změny v CON a ukončí práci s TSRE5 
Discard and Quit – ignoruje změny v souborech a ukončí program 
Cancel – vypne dialogové okno a umožní pokračovat v práci 
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Vytvoření nové soupravy nebo otevření stávající 
 

• Vyberte již existující soupravu ze seznamu dostupných nebo kliknutím na File → New (Soubor → 
Nový) zahajte práci na sestavení nové soupravy. 

 
• Vyhledejte požadovanou položku vlaku v seznamu souprav a dvojitým kliknutím ji přeneste do 

konzoly: (konzolou je myšlen spodní řádek pracovní obrazovky, v němž sestavujete soupravu). 
 

• Můžete také jedenkrát kliknout na požadovanou položku soupravy (sloupec souprav), zvýraznit ji 
a poté použít jedno z následujících editačních tlačítek v horní části seznamu (sloupec vozidel): 

 

Add Beg     Vložit na začátek  
Přidejte označené vozidlo na začátek editované soupravy. 

 
Add Cur     Vložit na zvolenou pozici  

Přidejte označené vozidlo na aktuálně nastavenou pozici v soupravě 
 

Add End    Vložit na konec  
Přidejte označené vozidlo na konec editované soupravy 

 
Add Rand    Vložit náhodně  

Vytvoří seznam vámi vybraných vozidel, z kterého lze vytvořit pracovní soubor CON - ten se 

uloží v adresáři Trains / Consist / randomsets - jako nástroj pro další sestavování běžných 

souprav (nahodile z vybraných vozidel) a souprav s podobným řazením. Tento výběr vozidel 

můžete také uložit pro další použití (Save current list as) a opětovně načíst v rozbalovacím 
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seznamu souborů s WAG a ENG pro vytvoření náhodných souprav z takovýchto výběrů. 

Soubory autorem vybraných a uložených vozidel jsou k výběru v editačním okně „Random 

Consist“ (Náhodné soupravy) – viz pole „Or load List from Disk“. Údaj Number of Units určuje, 

kolik vozů bude z výběru přidáno do editované soupravy. Máte-li v tabulce filtrován menší počet 

vozidel, než je tato číselná hodnota, některá vozidla budou použita několikrát. POZOR! Pokud 

již máte otevřenu nějakou dříve vytvořenou soupravu (CON), nově vybraná a náhodně 

seřazená vozidla se automaticky připojují na její konec a to po stisknutí tlačítka Add Random 

(Připoj náhodně). 
Tlačítko Cancel uzavře okno „Random Consist“. Neuložený výběr vozidel bude ztracen! 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add Rand je součástí nástroje pro generování náhodně sestavené soupravy. Je navržen 

tak, aby upravil aktuálně otevřenou soupravu, když stisknete tlačítko Add Random (Vložit 

náhodně), nacházejícím se, jak bylo uvedeno, v dialogovém okně „Randomize Consist“ 
(Náhodná souprava). Editovaný soubor CON v pracovní konzoli ale neztratíte, protože ten 

čeká na potvrzení nebo odmítnutí změn (File – Save). 
 

Teoreticky lze vytvořit několik souborů takto vybraných vozidel, které lze použít 

k sestavení normálních provozních souprav za předpokladu dodržení stanovených 

postupů: 

File / New → zadání názvu nové soupravy File Name / Display Name → tlačítko ve 

sloupci vozidel Add Rand → výběr souboru vozidel Or load List from Disk → vložení Add 

Random → editace pořadí vozidel v soupravě atd. → uložení hotové soupravy File / Save 

 

Poznámky: 

- je-li ve výběru vozidel lokomotiva, je nutné ji přemístit na začátek soupravy – může se   

  nacházet v prostředku vlaku; 

- další nástroje pro editaci vozidel v soupravě jsou plně dostupné (mazání, otočení, …); 

- pro sestavení jedné provozní soupravy je možné kombinovat několik různých výběrů 

  náhodně  řazených vozidel. 
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Jak uložit stávající soupravu 
 

• Pokud jsou pole File Name (Název souboru) a Display Name (Zobrazovaný název) prázdná, 
musíte do nich zadat požadované názvy aktuální soupravy. Údaj „File Name“ je však nepovinný a 
umožňuje použití diakritiky. Jelikož se tato funkce využívá nejen k sestavování souprav pro 
aktivity, ale i pro případné volné jízdy za účel poznání trati, testování vlastností vozidel atd., není 
zde požadavek dodržení shodných názvů v obou polích tak striktní. 

 
File→Save       Soubor → Uložit 

Uloží hotovou či rozpracovanou soupravu na disk jako soubor *.con. 

 

Nástroje pro tvorbu souprav (CON) 
 
(nástroje, uvedené v následujících kapitolách, jsou součástí hlavního menu v záhlaví okna editoru) 
 

Nástroje souprav „Consist“ 
Tyto funkce jsou určeny pro práci se sestavenými soupravami: 
 
Consist→Reverse      Souprava → Otočit 
 

Určeno k otočení, tj. ke změně směru celé soupravy. Pro otočení jednotlivých vozidel (ENG, WAG) 
existuje jiný nástroj. 

 
Consist→Clone       Souprava → Klonování 
 

Jde v podstatě o známý příkaz „uložit jako…“ Naklonuje označenou soupravu, vy si ji uložíte pod 
jiným názvem. Všechny ostatní náležitosti (složení atd.) zůstávají beze změn. 

 
Consist→Delete      Souprava → Smazat 
 

Odstraní bez náhrady vybranou soupravu (CON) z vašeho disku. 
 
Consist→Open in External Editor    Souprava → Otevřít v externím editoru 
 

V dostupné verzi TSRE5 je funkce již použitelná. Podobně jako u editace ENG / WAG (viz dále), je 
nutné vybrat ve sloupci souprav tu požadovanou a spuštěním tohoto příkazu se odpovídající 
soubor CON otevře v textovém editoru. A stejně jako v případě vozidel je při prvním použití nutné 
přidělit TSRE textový editor, ve kterém bude CON zobrazován. Volte podle toho, zda chcete CON 
v textové podobě pouze prohlížet nebo jej potřebujete editovat přímo. K tomu jsou vhodné 
pokročilejší textové editory typu PSPad nebo Notepad++. 

 
Consist→Save as Eng Set 
 

Tato volba se používá ke sloučení více vozidel do souboru. Viz kapitola: Sdružená vozidla 

 

Nástroje ENG / WAG 
Následující nástroje pomáhají např. v rychlé orientaci mezi soubory ENG / WAG a umožňují jejich 
editaci externím editoru: 
 
Eng→Find Consists       Eng → Najdi soupravu 
 

Provede vyhledávání podle zadaného filtru pomocí rozbalovací nabídky. V současné verzi TSRE5 
zřejmě nedostupné. Jako vyhledávací kritéria lze použít tlačítka Show (Zobrazit) a Filter (Filtr) 
v záhlaví sloupce souprav, nebo Type (Typ), Coupling (Spojení) a editační řádek Search 
(Vyhledat) v záhlaví sloupce vozidel. 

 
Eng→Open In External Editor     Eng → Otevřít v externím editoru 
 

Otevřete soubor ENG nebo WAG aktuálně vybrané položky v přidruženém textovém editoru (v 
souladu s ORTS). Soubory je pak možné přímo editovat a upravené uložit. Změny, např. v názvu 
atd. se projeví až po použití funkce Settings → Force reload ENG data (Nastavení → Rychle 
obnovit ENG data). Tím se provede opakované načtení souborů ENG. 
Tento postup PLATÍ též pro vozidla se soubory WAG! 
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Eng→Open Legacy ENG In External Editor     Eng → Otevřít odkaz na ENG v externím editoru 
 

Otevřete soubor ENG nebo WAG aktuálně vybrané položky (specifikováno podle MSTS). Chová 
se prakticky stejně jako u předchozí funkce. 

 
Eng→Refresh Shape         Eng → Obnovit model 
 

Znovu načte model  označeného vozidla z disku. 

 

Menu Replace - Nahrazování 
Nyní můžete snadno vyměnit jednotlivé části vybrané soupravy podle následujícího postupu: 
 

• Vyberte si soupravu, v níž potřebujete provést úpravu vozidel. Musí se zobrazit v dolní konzoli. 
 

• Najděte náhradní vozidlo ve sloupci ENG / WAG a vyberte jej (oranžové podbarvení 
zobrazovaného názvu). Ujistěte se, že je zobrazeno též v náhledovém okně ENG / WAG 
View. (POZOR! Neklikejte na něj dvakrát! Tím by se vozidlo zařadilo do editované soupravy.) 

 
• Použijte jednu z funkcí menu Replace - Nahrazování: 

 
Replace→Only Selected Unit       Nahrazování → Pouze jedno vozidlo 
 

Takto vyměníte aktuálně označené vozidlo (v konzoli soupravy) za nově zvolené ze seznamu 
dostupných vozidel. Výběr vozidla v soupravě se provede kliknutím levého tlačítka myši a 
příznakem správného výběru je červený rámeček kolem něj. 

 
Replace→Replace All units in selected consist     Nahrazování → Nahradit stejná vozidla ve  zvolené 

soupravě 

Tímto příkazem vyměníte jeden typ vozidla v aktuálně otevřené soupravě za jiný vybraný typ. Např. 
kliknete na vozidlo Falls1 v zobrazené soupravě, potom v seznamu dostupných vozidel kliknete 
jedenkrát na vozidlo Faccs tak, aby se zobrazilo v náhledu. Použitím této funkce dojde k výměně 
všech vagónů Falls1 v soupravě za zvolený Faccs. Není nutné měnit každé vozidlo jednotlivě, což 
může značně zkrátit práci. 
Pozn.: vyměněna budou jen ta vozidla, která přesně odpovídají výběru. Máte-li v soupravě jiný typ 
vozu Falls (tzn. s odlišným označením – např. Falls2) jeho náhrada nebude provedena. 

 
Replace→All units in all consists    Nahrazování → Všechna vozidla ve všech soupravách 

Funkce provede výměnu vybraného vozidla jiným ve všech soupravách, kde se vyskytuje. Podle 
výše uvedeného příkladu takto lze jednoduše nahradit veškerý výskyt vozu Falls1 za vůz Faccs ve 
všech dostupných soupravách, v němž se vyskytuje. Příkaz najde uplatnění např. při záměně 
vozidel za lepší verzi modelu, jiný typ apod. 
Tuto funkci je potřeba používat po důkladném uvážení! 

 

Menu View - Náhled 

Menu „Zobrazení“ poskytuje nabídku různých pracovních panelů, které lze podle libosti 
zapínat nebo vypínat a zvolit si tak optimální způsob, jakým se zobrazují jednotlivé 
komponenty okna Editoru souprav. 
 
Pokud jsou například vypnuty všechny pracovní panely, budete mít před sebou pouze prázdnou 
obrazovku. 
Jako optimální je doporučeno mít povolen Consist List (Seznam souprav), seznam Eng List 1 
(seznam dostupných vozidel), okno Eng View (Náhled vozidla) a okno Con View (konzole soupravy). 
 

Jako příklad můžeme využít možností View Menu (menu Zobrazit) a zde povolit Eng List 1 a též 

Eng List 2.Tato možnost je výhodná, pokud potřebujete v 1. panelu zobrazit např. dieselové 

lokomotivy a ve 2. panelu např. nákladní vagóny, aniž byste se museli zdržovat přepínání pomocí 

výběrových filtrů, které se nachází v záhlaví obou seznamů. 
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Filtry vozidel 

Type (Typ vozidla): ALL (všechna vozidla) 

   Electric (elektrické lokomotivy a jednotky) 

   Diesel (dieselové lokomotivy a motorové vozy / jednotky) 

   Steam (parní lokomotivy) 

   Carriage (osobní vagóny) 

   Freight (nákladní vagóny) 

   Tender (samostatné tendry) 

Coupling (Spřáhlo) ALL (všechny typy spřáhel) 

   Chain (řetězové spřáhlo) 

   Automatic (automatické spřáhlo) 

   Bar (tyčové spřáhlo) 

Pole Search (Vyhledat)  výběrové hledání podle vložených znaků – písmena, čísla 

Pole Num to add (Počet vložení) počet současně vložených vozidel označeného typu) 

 

Grafická podoba 3D modelu 
 
V konzoli, kde se zobrazují vozidla zpracovávané soupravy, je pro snazší orientaci použito 
rozlišovacích symbolů. První charakterizuje typ vozidla, číslice udává pořadové číslo v soupravě. 
Setkat se můžeme s těmito rozlišovacími znaky: 
 
D hnací vozidlo (ENG) – dieslová lokomotiva, motorový vůz, dynamický servis; 
E hnací vozidlo (ENG) – elektrická lokomotiva, hnací vozidla elektrických jednotek 
S hnací vozidlo (ENG) – parní lokomotiva 
F tažené vozidlo (WAG) – nákladní vagón, neprovozovaná lokomotiva (zpravidla „mimo službu, 

porucha“), statický servis apod 
C tažené vozidlo (WAG) – osobní vagń, vozy v elektrických a motorových jednotkách, statický 

servis apod. 
T tendry parních lokomotiv 
 
Vyberte požadovanou položku pomocí myši (levé tlačítko). Vybrané vozidlo bude mít kolem sebe 
červené zvýraznění. Použití pravého tlačítka má za následek kromě označení vozidla též otevření 
kontextového menu – viz další část textu Možnosti kontextové nabídky. 
 
 
 
 
 
 
 
 
 
 
 

Akce dostupné prostřednictvím klávesnice 
 
Klávesa F     Obrátit 

Tímto příkazem se změní orientace aktuálně označeného vozidla v soupravě. Podle výše 
uvedeného obrázku bude provedeno otočení vozidla pod označením [F2]. 

 
Delete       Smazat  

Smaže aktuálně označenou položku soupravy a posune na její místo vozy zprava. 
 
Left or Right          Šipka „vpravo“ nebo „vlevo“ 
 

Šipkami kurzoru vlevo nebo vpravo měníte pozici označeného vagonu nebo lokomotivy uvnitř 
soupravy.  
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Můžete také použít posuvnou lištu ve spodní části okna k posunutí náhledu doleva a 
doprava, pokud je souprava větší, než je šířka obrazovky. 

 

 
Možnosti kontextové nabídky 
Když kliknete pravým tlačítkem myši na vagón nebo lokomotivu v sestavené soupravě, označí se 
červeně a zobrazí se místní nabídka s dostupnými akcemi. 
 
Dostupné akce pomocí místní nabídky „Kliknutí pravým tlačítkem“ 
 
Flip       Otočit  

Otočit: tímto se změní orientace aktuálně označeného vozidla v soupravě. 
 
Move Left        Přesun vlevo  

Přesune označený vagón nebo lokomotivu o jednu pozici vlevo. 
 
Move Right      Přesun vpravo  

Přesune označený vagon nebo lokomotivu o jednu pozici vpravo 
 
Delete       Smazat  

Odstraní ze soupravy označený vagon nebo lokomotivu 
 
Copy      Kopírovat  

Zkopíruje do schránky vybrané vozidlo, které je potom možné vložit jak do aktuální soupravy, tak 
do jiné (po jejím otevření v konzoli). 

 
Paste Right  

Zkopíruje vybranou položku do zvolené soupravy a vloží ji vpravo od právě označeného vozidla. 
     Chcete-li zkopírovat položku z aktuální soupravy a vložit ji do jiné, proveďte následující kroky: 
 

1. Pomocí kontextové nabídky zkopírujte položku vozidla z aktuální soupravy 
 

2. Vyberte název soupravy, do níž potřebujete vozidlo přidat, ze seznamu dostupných. 
 

3. Editor souprav otevře vybranou soupravu a zobrazí ji v konzoli. 
 

4. Opakovaným použitím kontextové nabídky máte možnost vložit další vagon nebo                 
lokomotivu do soupravy směrem vpravo od aktuální pozice. 

 
5. V případě potřeby pak můžete pomocí kontextové nabídky nebo klávesových zkratek  

definitivně určit polohu nově vloženého vagonu nebo lokomotivy. 

 

Menu 3D náhledu - vozidla 

 
Tyto položky menu odkazují na velký obrázek 3D modelu v pravém horním rohu editoru souprav. 
 
Náhled vozidla poskytuje uživateli při skládání vlakové soupravy (CON) dostatečnou představu o 
provedení a grafické kvalitě označeného vozidla. 
 

Do určité míry tak supluje dříve hojně využívaný externí nástroj Shape View (též SView), samozřejmě 
s omezenými možnostmi. I tak vložené funkce umožňují veškeré základní operace s náhledem na 
označené vozidlo – lokomotivu i vagón. 
 
Pravé tlačítko myši + pohyb nahoru / dolů – natočení vozidla podél podélné osy; 
Levé tlačítko myši + pohyb vpravo / vlevo – otáčení vozidla podél příčné osy; 
Kolečko myši - zvětšení / zmenšení náhledu 
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Zobrazení v této části lze přepnout výběrem položky View → EngView item (Zobrazení → Položka 
zobrazení vozidla). 
 
Shape View: Reset       Zobrazení modelu: Obnovit 
 

Příkaz obnoví nominální parametry zobrazení (boční pohled), pokud bylo v prohlížeči s modelem 
nějak hýbáno / natáčeno. Natáčení modelu v okně se provádí při stisknutém levém tlačítku, 
naklápění při stisknutém pravém tlačítku. 

 
Shape View: Copy Image     Zobrazení modelu: Zkopírovat obrázek 
 

Příkaz zkopíruje aktuální 3D zobrazení na vybrané vozidlo do ClipBoard pro další použití 
 
Shape View: Save        Zobrazení modelu: Uložit 
 

Uložte kopii 3D náhledu na disk. 
 
Shape View: Set Color    Zobrazení modelu: Nastavení barev 
 

Zde si nastavte barvu pozadí pro 3D zobrazení modelu z dostupné barevné palety. 
 
Con View: Set Color    Zobrazení soupravy: Nastavení barev 
 
Nastavte barvu pozadí pro konzoli zobrazení soupravy z dostupné barevné palety. 
 

•  V současné době neexistuje žádná kontextová nabídka pro část Podrobnosti modelu (Model 
Details) v editoru. 

 

Sdružená vozidla 
 

Co znamená výraz „sdružená vozidla“?  
Sestavy sdružených vozidel jsou speciálně vytvořená zapojení např. hnacích vozidel pro co 
nejlepší zážitek při tvorbě a řízení vícemotorových nebo složených sestav / jednotek (např. 
dvouskříňové elektrické lokomotivy – řada 131, o sestavě vozidel můžeme též mluvit v případě 
elektrických  a motorových jednotek – řada 471, 814, 844…),  též pro parní lokomotivy s tendry 
atd. (475 + 932) Jde o soupravy, jejichž zapojení je funkčně dané a neměnné. 

 
Na obrázku je příklad vytvořené sestavy dieselových lokomotiv, ustáleně používané např. pro 
vedení těžkých nákladních vlaků na tratích USA. 
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Díky této funkci můžete například dosáhnout toho, aby se při definici soupravy připojila parní 
lokomotiva a jí odpovídající tendr automaticky, na jedno kliknutí. Je možné vytvořit několik různých 
sestav pro jednu lokomotivu / vagón: 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

 
Jak pracuje funkce „sdružená vozidla“? 
Možnosti uložení: 
 

1. Sdružená souprava s názvem = eng_name  (název lokomotivy) →  eng set  (název sestavy dle 
lokomotivy)    • Viz info níže. 

 
2. Sdružená souprava s názvem = eng_name # „něco“ → eng set+ (název sestavy dle lokomotivy + 

rozlišující znaky) 
 
Stroj musí být zahrnut v sestavě sdružených vozidel. 
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• Komentář pro vývojáře: Myslím, že v tomto případě je možné ignorovat metodu č. 1, 
protože spousta defaultních vlakových souprav je definována názvy, které se řídí 
podle jejich lokomotiv. Pro některé vlaky tento postup sice funguje normálně, ale 
většinou musíte vytvořit vlastní sestavy sdružených strojů. 
 
 
Při práci na sestavování takovýchto souprav / jednotek nezapomínejte na zpětnou vazbu, 
tj. na prověřování, zda již souprava (CON) s plánovaným označením náhodou 
neexistuje. 
 

 

Jak vytvořit novou sestavu sdružených vozidel? 
 

• Založte novou soupravu (File – New) 
 

• Vyberte a do konzole vložte všechna vozidla, která potřebujete v soupravě mít 
 

• Zadejte název souboru (políčko „File Name“), který používáte, na základě názvu hnacího vozidla, 
nebo jej nechte prázdný. Editor si sám doplní název podle typu 1. vozidla v sestavě. 

 
• Klikni na Consist → Save as eng set (Souprava → Uložit jako sdruženou soupravu). Takto 

vytvořená sdružená souprava se rovněž objeví v seznamu ostatních. 

 

Tuto metodu můžete také použít rovněž k vytvoření sestavy sdružených vozidel 
bez použití lokomotivy. Sestava bude propojena s první položkou v seznamu.  

 
 

 
• Pokud se potřebujete sdružené soustavy zbavit, najděte její přesný název v seznamu a smažte ji. 

Řiďte se názvem podle údaje v informačním panelu – viz následující část. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Použití vytvořených sdružených souprav: 
Pokud je vozidlo součástí nějaké sdružené soupravy jako první v pořadí, objeví se v jeho 
informačním panelu (pod 3D náhledem) manipulační pole Eng Sets Detected (Zjištěna sdružená 
souprava). V prvním poli je rozbalovací nabídka sdružených souprav, ve kterých se vozidlo, 
označené v seznamu, nachází. Po rozbalení a výběru se do konzoly soupravy přenese celá 
sdružená souprava najednou – tlačítko Add to Consist (Vložit do soupravy). Další varianta vložení 
je tlačítkem Flip and Add to Consist (Otočit a vložit do soupravy). 
Tlačítka Show / Hide (Ukázat / Skrýt) slouží k zobrazení nebo skrytí celé sdružené sestavy, v níž 
je vozidlo zařazeno. 
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Dodatek 1. pro TSRE-5 (2022) 
 
Od zveřejnění překladu tohoto tutorialu uplynula určitá doba, během níž TSRE-5 doznal řady 
změn. V tomto dodatku se zaměříme na oblast tvorby aktivit (AE). 
V této oblasti došlo k oživení a vyladění dalších dříve plánovaných funkcí a nástrojů, případně 
odstranění známých nedostatků. Jedná se o možnosti vkládání a editace úseků pomalých jízd, 
naznačení možnosti vkládání nefunkčních návěstidel v budoucnu, editace časových a místních 
událostí a pokročilého selektivního ukládání rozdělané práce. Pro zopakování: 

 
 
Restricted Speed Zone List (Tabulka úseků 
s omezenou rychlostí – pomalá jízda) 
 
 
Failed Signals List (Tabulka nefunkčních 
návěstidel) 
 
 
Events (Události) 
 
Activity Info (Základní údaje o aktivitě) 
 
Experimental (Experimentální) – nefunkční, 
nepoužívat! 
 
General (Všeobecné) 
 
 
 

Restricted Speed Zone List  (Pomalá jízda) 
– přehled funkčních tlačítek (musí být otevřena nová nebo stávající aktivita a musí existovat aspoň 
jeden úsek pomalé jízdy): 
 

Jump to (Přejdi na) – přejde na začátek zvoleného úseku pomalé jízdy dle seznamu – 
souřadnice. Pokud v aktivitě žádná pomalá jízda neexistuje, je funkce nedostupná! 
New (Nový) – definice nového úseku pomalé jízdy; vloží dva červené jehlany, symbolizující 
začátek a konec úseku pomalé jízdy na zvolené místo do trati. Nastavení délky úseku: označte 
jeden z nich (zpravidla koncový) pravým tlačítkem a aktivujte plovoucí menu: Edit → Select tool. 
Délka úseku jízdy omezenou rychlostí se stanoví posunem označeného jehlanu. Tento postup 
platí i pro zkrácení editovaného úseku. Červená čára mezi nimi symbolizuje jak délku úseku,  tak 
naznačuje směr k druhému vymezovacímu jehlanu (viz obrázek na následující stránce): 
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Delete (Smazat)  - smaže aktuálně zvolený úsek pomalé jízdy, nelze vrátit; 
Delete all (Smazat vše) – vymaže všechny vložené úseky bez náhrady. 

 
 
Pozn.: obdobně jako o MSTS-AE se rychlost v tomto úseku omezuje na 30 km/h. 
 

 
Pozn.: Vede-li uvažovaný úsek jízdy s omezenou rychlostí přes výměny, je nutné jej 
rozdělit na několik dílčích a ukončit je před každou projížděnou výhybkou. 
 
 

Failed Signals List (Tabulka nefunkčních návěstidel - nepřístupné) 
Práce s nefunkčními návěstidly je dosud nevyřešená a použití jakéhokoliv tlačítka má za následek 
pád editoru, což může způsobit velké škody zejména pro neuloženou aktivitu! 
– přehled funkčních tlačítek (musí být otevřena nová nebo stávající aktivita), jak je předpokládán: 
 

Jump to (Přejdi na) – výběr nefunkčního návěstidla a přechod na něj; 
Disable (Nepřístupné) – definice nefunkčního návěstidla není dosud programátorsky vyřešena. 

Tlačítko bude zřejmě po vyřešení nástroje přejmenováno;  
Delete (Smazat)  - navrátí vybrané nefunkční návěstidlo do funkčního stavu, nelze vrátit; 
Delete all (Smazat vše) – zprovozní všechna nefunkční návěstidla bez náhrady. 

 
Events (Události) 
Jako u předešlých nástrojů vyžaduje použití editoru událostí existenci otevřené libovolné aktivity. 
Po kliknutí na tlačítko Open Event Editor se otevře následující okno, díky němuž lze vložit nebo 
upravovat řadu informací a podmínek, platných pro aktuální aktivitu. Zobrazení je pro všeobecné 
okno, bez výběru typu události. 
 

Action – základní / obecná událost; 
Location – událost vázaná na pozici v aktivitě (místo v trase); 
Time – událost vázaná na čas v aktivitě (čas počítaný podle startu aktivity). 
 

Jednotlivé typy událostí budou popsány později. 
 
Editační okno událostí v aktivitě – viz následující stránka: 
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Výběrové okno editace událostí – obecný popis 

 
 
1. Pole se seznamem dostupných událostí v otevřené aktivitě. Obsah závisí na zvoleném typu; 
2. Tlačítko Type: přehled a výběr přednastavených událostí, které musí hráč v aktivitě splnit: 

 Stop a Final Station: zastavit v cílové stanici, 
 Pick up Wagons: připojit / přibrat vozy, 
 Assemble Train: sestavit vlak, 
 Assemble train at Location: sestavit vlak na pozici, 
 Drop off Cars at Location: odpojit vozy na pozici, 
 Pick up a Passengers: naložit cestující, 
 Rearch Speed: přesný význam nebyl zjištěn, 
 Make a Pickup: provést nakládku. 

3. Pole Name: název stávající / nové události. Název lze editovat; 
4. Výběr Activation Level: aktivační úroveň 0-4, nominálně nastaveno 1. 

0 – deaktivovaná událost (neproběhne, dokud nebude aktivována v průběhu hry), 
1-4 – stupeň události se snižuje / zvyšuje na základě chodu aktivity. 

5. Pole Triggered Text: text zobrazený v závěrečném vyhodnocení aktivity v případě splnění; 
6. Pole Untriggered Text: text zobrazený v závěrečném vyhodnocení aktivity v případě nesplnění; 
7. Pole Notes: místo pro poznámku autora aktivity o detailech události; 
8. Volba Disable pause: deaktivovat přerušení hry (hra se nepřeruší během hlášky o události); 
9. Volba Reversible: reversibilita, dostupná jen pro základní události. Přesný význam nebyl zjištěn; 
10. Pole Outcomes: výstup výsledků pro danou událost (text, změna aktivační úrovně, …). 

Přehled dostupných funkcí se nastavuje z rozbalovacího seznamu Select Outcome, tlačítko 
Action – viz níže. Může jich být více; 

11. Tlačítko Add new: umožní výběr případně doplnění dalšího výstupu události dle nabídky; 
12. Tlačítko Remove Selected: odstraní vybraný výstup události z pole Outcomes; 
13. Přehled Selected Outcome s rozbalovacím seznamem výstupů události (akcí): 

 None: žádná akce, nebyl vybrán žádný výstup. 
 Display a Message: zobrazit zprávu, vloženou do textového pole – viz popis místní nebo 

časové události; 
 Complete Activity succesfully: aktivita byla dokončena úspěšně; 
 End Activity without Succes: aktivita nebyla úspěšně dokončena; 



 

 
TSRE5 – Editor aktivit 

30 

 

 Increase an Event‘s ActivationLevel: zvýšit aktivační úroveň zvolené události o 1; 
 Decrease an Event‘s ActivationLevel: snížit aktivační úroveň zvolené události o 1; 
 Restore an event’s Activation Level: obnovit původní aktivační úroveň události; 
 Activate an Event: aktivovat událost (vložit číslo události); 
 Start ignoring speed limits:  
 End ignoring Speed Limits:  
 Play Sound from File: přehrát zvukový soubor: kdekoliv, venku, v kabině. 

 
Použití zvukového výstupu předpokládá existenci zvukového souboru ve formátu *.wav, 
který musí být umístěn do složky SOUND hlavního kořene MSTS nebo uvnitř profilové 
složky trati, jak je definováno v systému MG-OR. Více viz v MG-OR – Nastavení – karta 
Obsah / Instalační profil. 
Do řádku “Sound File“ zadejte úplný název zvukového souboru včetně extenderu WAV. 
Ve výběru “Sound Type“ nastavte prostor, v němž má být zvuk slyšitelný. Regulace 
hlasitosti zvuku nebyla zjištěna. 

 Change a Weather: změna počasí (v této fázi vývoje TSRE-5 zatím nelze přímo použít).  
 

V závislosti na zvoleném výstupu se v této části zobrazí nástroje, potřebné pro jeho 
definici, např. pole pro zapsání zprávy, výběr další ovlivňované události (aktivační 
úroveň), vložení zvukového souboru (viz tento příklad) atd. 
 
 

14. Tlačítko New … Event: vytvoření nové základní / místní / časové události (dle výběru); 
15. Tlačítko Delete: nenávratně smaže vybranou událost. POUŽÍVAT OPATRNĚ! 

 
 

Nabídka dostupných výstupů (Outcome) je shodná pro všechny tři typy událostí. 
 

 
 
Délka textu ve výstupu zobrazení zprávy (Outcomes – Display a message) není, oproti 
MSTS-AE, limitována délkou 256 znaků a lze bezproblémově použít znaky využívající 
českou diakritiku. Takto upravený text ale není možné znovu otevírat např. v MSTS-AE, 
který toto neumí a mohl by hlášku zkreslit. 
 

 

Editace základní události 
Tyto události zahrnují stanovené úkoly, které musí hráč splnit. Bez jejich splnění (např. připojení / 
odpojení vagónů) nemůže pokračovat dále nebo aktivitu ukončí neúspěšně. 
 

Vyberte kartu „Action“ 
(popis polí, funkčních tlačítek, popisek, které nejsou obsaženy v základním přehledu výběrového 
okna nebo se od nich nějakým způsobem liší – viz následující stránka): 
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1. Pole se seznamem dostupných událostí v otevřené aktivitě. Obsah závisí na zvoleném typu; 
2. Tlačítko Type: přehled a výběr přednastavených událostí, které musí hráč v aktivitě splnit. Seznam 

událostí je uveden výše (2); 
3. Pole Outcomes: výstup výsledků pro danou událost (text, změna aktivační úrovně, …). 

Přehled dostupných funkcí se nastavuje z rozbalovacího seznamu Select Outcome, tlačítko 
Action – viz níže. Může jich být více; 

4. Přehled Selected Outcome s rozbalovacím seznamem výstupů události  / akcí – viz výše (13). 
 
Výstupem této základní události bude úspěšné ukončení aktivity po zastavení v cílové stanici. 

 
Podoba sekce Selected Outcomes se mění podle vybraného / dostupného výstupu 
události, v závislosti na její charakteristice – textové pole pro zprávu, definice 
souboru, výběr jiné ovlivněné události, změnu aktivační úrovně… 
 
Pole výběru výstupů odpovídá zhruba kartám Akce z definičního okna událostí MSTS 
AE. Na rozdíl od MSTS AE však TSRE-5 není limitován počtem povolených výstupů. 
 

Výstupem úspěšného provedení základní události „připojit vozy“ může být např. aktivační změna 
jiné události, která hráče pustí do další etapy aktivity. Bez jejího splnění nelze pokračovat dále. 
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Editace místní / poziční události 
 
Vyberte kartu „Location“ 
(popis polí, funkčních tlačítek, popisek, které nejsou obsaženy v základním přehledu výběrového 
okna nebo se od nich nějakým způsobem liší) 

 
 
1. Pole se seznamem pozičních / místních událostí pro danou aktivitu. Název je v režii autora aktivity; 
 

Číslování události nemusí navazovat na událost předešlou / následující. Vzhledem 
k běhu aktivity tedy může být „na přeskáčku“ – viz přehled pozičních událostí: Pozice 18 
až 20 se odehrají dříve, než např. Pozice 17., třebaže jsou v seznamu až za ní. Má to 
výhodu v tom, že při dodatečném vložení nové události (vynucené např. odlaďováním 
aktivity) není nutné stávající události složitě přečíslovávat. 

 

2. Info řádek Position: informace o souřadnicích bodu místní události; 
3. Tlačítko Jump to Location: přesune kurzor / marker na místo vybrané poziční události; 
4. Tlačítko Pick New Location: umožní přesunout vybranou událost do jiné pozice (odlaďování atd.); 
5. Pole Radius: poloměr účinnosti této události. Volí se s ohledem na očekávanou následnou činnost; 
6. Výběr Train must stop: podmínka „Vlak musí zastavit“. Zastavení je při plnění aktivity kontrolováno; 
7. Přehled Selected Outcome s zvoleným výstupem / akcí Display a Message (Zobraz zprávu); 
8. Pole Message: pole pro zápis textu zobrazovaného hlášení. Lze použít českou diakritiku; 
9. Tlačítko New Location Event: vytvoření nové poziční události; 
10. Tlačítko Delete: smaže nenávratně vybranou poziční událost. POUŽÍVAT OPATRNĚ! 
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Pro zvýraznění místa pozičních událostí, je nutné mít zatrhnuto zobrazování View → 
Interactives v hlavním menu editoru. 
 
 
Chcete-li v náhledovém okně TSRE-5 zobrazit zadaný název místní události (např. “Pos0 
ukončení aktivity“), musíte po zadání parametrů a vložení události do očekávané pozice 
aktivitu uložit, vypnout a znovu nastartovat TSRE-5. Po otevření aktivity a přesunu na místo 
vložení by už měl název události odpovídat. 
 

V této události (nazvané Pozice1 pobyt Opava A) se po projetí vyznačeného aktivačního místa na trati 
objeví okno s pokyny, popsanými v poli Selected Outcome - Message. Zároveň se aktivační úroveň 
události automaticky sníží o 1. 
 

Příklad použití - ukončení aktivity mimo cílovou stanici 
Jedná se o situaci, kdy existuje požadavek ukončit aktivitu na jiném místě, než je cílová stanice. 
Místo ukončení je definováno např. na širé trati. K tomu se hodí právě poziční událost 
Běžně je aktivita ukončována v cílové stanici, po uplynutí stanovené doby pobytu v ní. Je to dáno 
nominálním nastavením základní události – viz pole se seznamem (1.), Outcomes (3.) a tlačítko 
Type (2.) příslušného editačního okna (obrázek karty ACTION). 
 

Postup: 
 Otevřít okno Events, zde přejít na kartu obecných událostí Action; 
 Přednastavená podmínka pro ukončení aktivity – zastavení v cílové stanici: 

Typ základní události – Stop at Final Station (Zastav v cílové stanici); 
Výstup události – Complette Activity siccesfully (hlášení Aktivita dokončena úspěšně). 

 
 Vybrat akci “Základní událost“ a zrušit její výstup (pole Outcomes) pomocí tlačítka Remove 

Selected. Tím se odstraní nominálně nastavený výstup ukončení aktivity po zastavení v cílové 
stanici; 

 Uložit změny pomocí selektivního ukládání Save Activities – blíže viz následující kapitola. 
Změna se promítne v souboru *.act, kód [A]; 

 Znovu otevřít okno Events, tentokrát na kartě Location (místní / poziční událost); 
 Pomocí tlačítka New Location Event (9.) založit novou poziční událost a v poli Event / Name ji 

vhodně pojmenovat – viz následující příklad: 

 
 Vyhledat požadované místo vložení události na trati (okno Navi) a pomocí tlačítka Pick New 

Location ji na toto pozici umístit. Souřadnice jsou zřejmé z informačního řádku Position. 
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Rychlé ukončení: 
 Pomocí rozbalovacího seznamu Action (7.) vložit do pole Outcomes / Message (8.) následující 

výstup nabídky:   

 
 V překladu „“Aktivita dokončena úspěšně“. Výsledkem je ukončení aktivity podobným stylem 

jako v případě definovaném základní událostí. 
 
Alternativní ukončení: 
 Pomocí rozbalovacího seznamu Action (7.) vložit do pole Outcomes / Message (8.) následující 

výstup:   

 
V překladu “Zobrazit zprávu“. 
Jak bylo popsáno dříve – tlačítka Add New a Remove selected slouží k zavedení nového výstupu  
nebo ke smazání vybraného výstupu v nabídce Outcomes. 
 
Výsledkem takto definované události je to, že vlak odjede z poslední (cílové stanice) dále a po 
přejetí vymezeného místa bude vypsána hláška o možném ukončení, kterou uživatel volně 
definoval v poli Message (zde např. oznámení “Dílčí úsek prověřen“). 
Výstup “Zastavení bez ohledu na rychlostní limit“ je použit pouze jako ilustrativní pro možné 
kombinování různých akcí. V tomto případě musí hráč nejdříve zastavit ve vymezeném prostoru 
Radius (5.) a až poté bude zobrazeno hlášení o možnosti ukončit aktivitu. Úspěšný průběh 
události je samozřejmě podmíněn zatržítkem pro povinné zastavení – Train must stop (6.). 

 
Samozřejmě je možné použít i poněkud odlišný postup – podle zkušeností a 
požadavků autora aktivity. V podstatě ale může stačit pouhé hlášení... Uvedený případ 
výstupu se zastavením bez ohledu na rychlostní limit byl použit jen jako příklad. 
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Editace časové události 
 
Vyberte kartu „Time“ 
(popis polí, funkčních tlačítek, popisek, které nejsou obsaženy v základním přehledu výběrového 
okna nebo se od nich nějakým způsobem liší) 

 
1. Pole se seznamem časových událostí pro danou aktivitu. Název a popis jsou v režii autora aktivity; 

 
Časy jednotlivých událostí nemusí nutně navazovat na předcházející, podobně jako u 
místních. Požadavek na dodatečné vložení nové časové události nebo vypuštění 
původně definované vzniká např. během odladění aktivity a podobně. 
 

2. Informační pole Activation Time: vložení času aktivace / spuštění události. Čas se počítá od 
začátku aktivity (čas 00:00:00) a není nutné zadávat údaj ve vteřinách, jako tomu bylo u MSTS-AE; 

3. Přehled Selected Outcome s zvoleným výstupem Display a Message (Zobraz zprávu); 
4. Pole Message: pole pro zápis textu hlášení. Lze použít českou diakritiku; 
5. Tlačítko New Time Event: vytvoření nové časové události; 
6. Tlačítko Delete: nenávratně smaže vybranou časovou událost. POUŽÍVAT OPATRNĚ! 

 

V uvedeném příkladu dojde v čase 3 minuty a 2 vteřiny po zahájení aktivity k zobrazení zprávy, 
uvedené v poli Message. Zároveň se aktivační úroveň události automaticky sníží o 1. 
 
 
… a nyní další nástroje editoru aktivit: 
 
Activity Info (Základní údaje o aktivitě) 
Tyto údaje a popis jejich významu jsou dostatečným způsobem vysvětleny v samostatné kapitole 
na str. 5 a 6., tudíž není nutné se k nim vracet. 
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General (Všeobecné) 
Pod tlačítkem Save Activities se skrývá pokročilý systém ukládání rozpracované aktivity. Dovoluje 
uložit najednou celou aktivitu nebo pouze její vybranou část: 

 
Tento způsob uloží změny ve VŠECH souborech aktivity, jež byly nějakým způsobem změněny. 
V tomto případě v souboru *.act (symbol [A]) a v souboru *.srv (symbol [S]). 
Setkat se můžete ještě se souborem *.trf (symbol [T]) – definice okolního AI provozu. 

 
V tomto případě bude uložena změna JEN v souboru *.act. Změny v servisech *.srv v tomto 
případě nebudou uloženy. 
V následujícím případě se provede uložení pouze vybraného souboru typu *.srv. Změny v *.act 
zůstanou neakceptovány až do dalšího použití nástroje General / Save. 

 
Samozřejmě – souborů *.srv může být najednou změněno více v rámci jedné aktivity. 
Během tvorby aktivity se mohou objevit soubory jiného typu – např. *.trf (okolní 
provoz). 
 
 
I když bude použito výběrové uložení, změny v dalších souborech aktivity nebudou 
ztraceny a editor je nabídne později během dalšího ukládání nebo při ukončení práce.  
 
 
Pozor – správné využití všech nabízených možností selektivního ukládání vyžaduje 
důkladnou znalost struktury souborů aktivity (A, T, S)! Aktivitář by měl přesně znát, 
jaké hodnoty a údaje se v jednotlivých souborech ukládají, aby předešel nežádoucím 
změnám a komplikacím při návrhu a sestavování aktivity – např. kde všude jsou 
specifikovány servisy hráče a okolního provozu, jízdní řády, události, trasy atd. 

 
Finální uložení celé aktivity nebo před ukončením práce s TSRE-5 je možné provádět nastavením 
příkazu z hlavního menu: Route→Exit nebo klávesovou kombinací [Alt]+[F4]. 
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V poli Save Changes in Route je přehled všech dílčích souborů aktivity, které byly editovány, do 

kterých bylo nějakým způsobem zasahováno. 
Tlačítko Save and Quit: editor uloží práci (všechny soubory)  a vypne se. Data budou uložena; 
Tlačítko Discard and Quit: AE TSRE-5 se vypne bez uložení práce. Nová data, dílčí soubory a 

nastavení aktivity budou ztracena, tj. zachována ve výchozí podobě nebo v podobě při 
posledním ukládání; 

Tlačítko Cancel: zruší operaci bez uložení, avšak editor zůstane otevřený a je možné pokračovat 
v další práci. 

 
 
Podobně jako v předchozích případech ukládání hotové práce je možné uložit pouze 
vybrané soubory (Save and Quit) a jiné ignorovat (Discard and Quit). 
 

 
A na úplný závěr několik postřehů k práci s Editorem aktivit TSRE-5: 
 Editor v současném stavu nedokáže zobrazit značení kolejí a vleček na stanicích i 

napojených z širé tratě. 
 Editor zatím nedisponuje žádným nástrojem, který by umožňoval „přehrát“ situaci a otestovat 

správnost chodu aktivity (zejména chování okolního provozu) ve vybraném úseku a čase. 
 Jelikož správné odladění aktivity z hlediska hráče i okolného provozu nelze nasimulovat ani 

v rozsahu, dostupném v MSTS-AE, je nutné znovu a znovu spustit aktivitu a odehrát ji od 
samého začátku. Použití uložených pozic SAVE je neúčinné, protože v záznamu jsou kromě 
jednotlivých servisů zapsány trasy, řazení souprav, jízdní řády a další prvky aktivity. 

 Co se týče pohybu editoru po trati, je poněkud těžkopádnější zejména u rozsáhlých tratí. 
Tento pohyb potřebujeme zejména při vkládání pomalých jízd a událostí. Jeden z postupů 
předpokládá využití navigačního okna: nalistujeme nejbližší stanici / kolej a „přeskočíme“ do 
jejího prostoru, pomocí myši a kláves pro ovládání kurzoru najedeme na požadované místo 
v trati a vložíme definovanou událost, úsek pomalé jízdy, v budoucnu možná i označíme 
nefunkční návěstidlo atd. Samozřejmě – stejný postup je nutno aplikovat i při editaci již hotové 
události. Metoda vyžaduje poměrně pokročilou orientaci v trati, znalost zeměpisu a podobu 
jednotlivých lokalit. 

 
K vytvoření tohoto dodatku byl použit TSRE-5, verze 0.7.012. 
 
napsal: Venny 
připomínky a upřesnění: Frosty 
 
Zpracováno 09/10 2022 
 
 
Děkujeme Poisonovi za zveřejnění rozšířeného překladu vč. tohoto dodatku. 
 
 
 


